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5. SEDAN GEOMETRY—VIRTUAL CLEANUP 

In this tutorial you will import an IGES file containing the geometry for a sedan automo-

bile, clean up the geometry, and mesh it with triangles and tetrahedra. 

In this tutorial you will learn how to: 

• Import an IGES file 

• Specify the way in which the geometry will be colored 

• Connect edges, using a manual and an automatic method 

• Merge faces 

• Create a triangular surface mesh 

• Mesh a volume with a tetrahedral mesh 

• Prepare the mesh to be read into FLUENT 5/6 

5.1 Prerequisites 

This tutorial assumes you have worked through Tutorial 1 and, therefore, that you are 

familiar with the GAMBIT GUI. 
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5.2 Problem Description 

The problem to be considered is shown schematically in Figure 5-1; it is the external body 

of a luxury sedan. You will generate a mesh on the outside of the car body; therefore, you 

will create a brick around the sedan to represent the flow domain. 

 

Figure 5-1: Sedan geometry 
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5.3 Strategy 

In this tutorial, you will create a fully unstructured tetrahedral mesh around a car-body 

geometry imported as an IGES file. This tutorial illustrates the steps you would typically 

follow to prepare an imported CAD geometry for meshing. The imported geometry is 

“dirty”—that is, there are gaps between some of the surfaces that make it unsuitable for 

creating a CFD mesh. After examining the raw imported geometry to identify its 

problems, such as unconnected edges, you will clean up the geometry using the tools 

available in GAMBIT. 

Most of the gaps can be fixed automatically either during mesh import or subsequently by 

means of the “connect edge” command. The original CAD geometry is not modified dur-

ing the fixing process; the modifications required to eliminate the gaps are made using 

“virtual” geometry, which lies on top of the “real” geometry. Some edges in the original 

geometry are very short and will be eliminated using the “vertex connect” command. 

Other edges are not automatically connected, because they are farther apart than the speci-

fied tolerance. You will connect such edges manually. 

The imported geometry includes a number of small surfaces, the edges of which may 

unnecessarily constrain the mesh generation process. Using the “merge faces” command, 

GAMBIT allows you to easily combine these surfaces prior to meshing. You can then 

have GAMBIT automatically create a triangular mesh on the car body. 

Since the imported geometry consists only of the car body, you need to create a suitable 

domain around the car in order to conduct a CFD analysis (this is loosely equivalent to 

placing the car in a wind tunnel). The remainder of the tutorial shows how to add a real 

box around the car body, use virtual geometry to create some missing faces, and finally 

stitch all faces together into a single volume. This volume can then be meshed (without 

any decomposition) using a tetrahedral meshing scheme. 
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5.4 Procedure 

1. Copy the file 

path/Fluent.Inc/gambit2.x/help/tutfiles/sedan.igs 

(where 2.x is the GAMBIT version number) from the GAMBIT installation area in 

the directory path to your working directory. 

2. Start GAMBIT. 

Step 1: Select a Solver 

1. Choose the solver from the main menu bar: 

Solver → FLUENT 5/6  

The choice of a solver dictates the options available in various forms (for 

example, the boundary types available in the Specify Boundary Types form). For 

some systems, FLUENT 5/6 is the default solver. The solver currently selected is 

shown at the top of the GAMBIT GUI. 
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Step 2: Import the IGES File As-Is 

File → Import → IGES … 

This command sequence opens the Import IGES File form. 
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1. Click on the Browse... button. 

This action opens the Select File form. 

 

a) Select sedan.igs in the Files list. 

b) Click Accept in the Select File form. 

2. On the Import IGES File form, unselect the Make Tolerant option, and click Accept. 

The IGES file for the sedan body will be read into GAMBIT (see Figure 5-2). 
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Zoom region

 

Figure 5-2: Imported sedan body 

3. Click the SPECIFY COLOR MODE command button  in the Global Control toolpad 

to change to the graphics display to connectivity-based coloring. 

The SPECIFY COLOR MODE command button will change to . When 

GAMBIT is in the connectivity display mode, the model is displayed with colors 

based on connectivity between entities rather than based on entity types. 

In this case, the colors of all edges in the graphics window will change to orange, 

indicating that the faces are not connected to each other—that is, that there are 

gaps between the edges that bound the faces. 

4. Ctrl-drag the mouse in the graphics window to create the zoom-region box shown in 

Figure 5-2, above (at the front of the sedan hood). When you release the mouse 

button, GAMBIT zooms in on the region. 

Figure 5-3 shows the zoomed region, illustrating an example of the gaps that exist 

between the faces that comprise the surface of the sedan. 
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Gap

 

Figure 5-3: Zoomed region showing unconnected faces on sedan hood 

In addition to gaps such as those shown in Figure 5-3, the geometry imported as-

is from the IGES file contains a number of small edges that can inhibit meshing of 

the model. GAMBIT provides options on the Import IGES File form that allow you 

to eliminate many of the gaps and short edges during import. The next step in this 

tutorial illustrates the use of one such option—Virtual Cleanup. 



SEDAN GEOMETRY—VIRTUAL CLEANUP Procedure 

© 1998–2007 Fluent, Inc. All rights reserved. 5-9 

Step 3: Reset and Import the IGES File Using Virtual Cleanup 

The Virtual Cleanup option on the Import IGES File form allows you to automatically 

eliminate many features, such as short edges and gaps between unconnected faces, 

during geometry import. By eliminating many such features during geometry import, 

you can greatly simplify the process of creating a meshable model. 

1. Reset GAMBIT. 

a) On the Command line, type reset, and press Enter. 

GAMBIT deletes the current geometry from the graphics window and resets 

the GUI. 

2. Reselect the FLUENT 5/6 solver from the main menu bar. 

Solver → FLUENT 5/6 

3. Open the Import IGES File form. 

File → Import → IGES … 

This command sequence opens the Import IGES File form. 
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GAMBIT retains the File Name selected in Step 2—that is, sedan.igs. 

4. Under Import Options: Stand-alone Geometry, select the No stand-alone edges check 

box. 
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This option instructs GAMBIT not to read in any edges that do not belong to 

faces or volumes. Such edges can be deleted after the geometry has been read into 

GAMBIT, but this option eliminates the extra step. 

5. Set the connect tolerance to 10% of the shortest edge by selecting the Virtual Cleanup 

toggle and specifying the Shortest Edge % at 10. 

This substep invokes an automated sequence of connect operations that attempt to 

clean up the imported geometry after it is read into GAMBIT. 

6. Click the SPECIFY COLOR MODE command button  in the Global Control toolpad 

to change to the graphics display to connectivity-based coloring. 

7. On the Import IGES File form, click Accept. 

The IGES file for the sedan body will again be read into GAMBIT. This time, 

however, GAMBIT will perform virtual clean-up operations to eliminate gaps 

and many small edges. As the clean-up operation progresses, edges that are ini-

tially displayed as orange (with the connectivity color mode on) will turn blue. 

Figure 5-4 shows the sedan geometry after import and clean-up operations are 

complete. 

 

Figure 5-4: Imported sedan body—with Virtual Cleanup option 
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Step 4: Eliminate Very Short Edges 

Even after the virtual clean-up operations, the imported IGES geometry is still some-

what “dirty”—that is, there are a few short edges and gaps between the faces that 

need to be repaired. In this step, you will eliminate the short edges. 

1. Find the shortest edge. 

GEOMETRY  → EDGE  → CONNECT/DISCONNECT EDGES  

This command sequence opens the Connect Edges form. 

 

a) Select All from the option menu to the right of Edges. 

b) Select the Real and Virtual (Tolerance) option. 

c) Press the Highlight shortest edge button. 

GAMBIT will highlight (in white) the shortest edge—along with its label—in 

the graphics window. 

d) Zoom in near the highlighted edge by pressing the Ctrl key while using the mouse 

to drag a box around the edge.  

Figure 5-5 shows the general area on the sedan that contains the shortest 

edge. Figure 5-6 shows a zoomed view of the edge. 
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Zoom region

 

Figure 5-5: Sedan—showing general area of shortest edge location 

Short edge

 

Figure 5-6: Sedan—showing zoomed area near shortest edge 
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2. Remove the shortest edge. 

GEOMETRY  → VERTEX  → CONNECT/DISCONNECT VERTICES  

This command sequence opens the Connect Vertices form. 

 

a) Select the Virtual (Forced) option. 

b) Pick the two endpoint vertices on the shortest edge. 

c) Click Apply. 

When GAMBIT attempts to connect these two vertices, an error message is 

generated stating that connecting these two vertices can cause invalid 

geometry. The geometry is protected from such operations by means of a 

default setting. 

d) Open the Edit Defaults form (select Defaults… from the Edit menu on the main 

menu bar), and change the value of the GEOMETRY.VERTEX.CONNECT_REMOVE_ 

SHORT_EDGE variable to 1. 

e) Repeat step (c). 

This time, GAMBIT connects the vertices. 

f) Click the FIT TO WINDOW command button  at the top left of the Global Con-

trol toolpad to see the full sedan in the graphics window. 
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g) Select the Virtual (Tolerance) option to activate the Highlight shortest edge button on 

the Connect Vertices form. 

h) Click the Highlight shortest edge button and repeat steps (a), (b), and (c) to eliminate 

the next shortest edge (see Figure 5-7). 

 

Figure 5-7: Sedan—showing location of next shortest edge 

By eliminating the two shortest edges in the model, you ensure that all edge mesh-

ing intervals are of reasonable size, thereby reducing the possibility of creating 

highly distorted elements during meshing. 
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Step 5: Automatically Connect All Remaining “Duplicate” Edges 

The imported IGES geometry is still “dirty”—that is, there are a few gaps remaining 

between the faces that make it unsuitable for creating a mesh. In this step, you will 

“clean up” the geometry automatically using the Connect Edges operation. 

1. Connect all edges in the geometry that are less than a specified tolerance apart using 

an automatic method. 

GEOMETRY  → EDGE  → CONNECT/DISCONNECT EDGES  

This command sequence opens the Connect Edges form. 

 

a) Select All from the option menu to the right of Edges. 

b) Select the Real and Virtual (Tolerance) option. 

You want GAMBIT to connect all real and virtual edges that are within a 

tolerance distance of each other. 

c) Retain the default value of 10 for the Shortest Edge %. 

d) Select the T-Junctions option. 



SEDAN GEOMETRY—VIRTUAL CLEANUP Procedure 

© 1998–2007 Fluent, Inc. All rights reserved. 5-17 

This option ensures that edges that do not match up correctly will be 

connected. GAMBIT will perform edge splits and then reconnect the geome-

try; an example is shown in Figure 5-8. 

Two edges Three edges

 

Figure 5-8: Connecting edges 

e) Click Apply. 

A few more edges turn blue in the graphics window as they are connected.  

! The edges on the symmetry plane will remain orange because they do not 

have any other edges with which they can be connected. 

2. Click the FIT TO WINDOW command button  at the top left of the Global Control 

toolpad to see the full sedan in the graphics window. 
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Step 6: Merge Faces 

In many cases, the IGES model contains more detail than you need for meshing. The 

imported geometry for the sedan includes a number of small faces, the edges of which 

may constrain the mesh generation process unnecessarily. In GAMBIT, you can 

merge faces together prior to meshing. 

1. Merge some of the faces on the sedan hood. 

GEOMETRY  → FACE  → SPLIT/MERGE/COLLAPSE/SIMPLIFY FACES 

R  

This command sequence opens the Merge Faces form. 

 

a) Under Type, select Real and Virtual (Forced). 

b) Zoom in to the hood of the sedan by holding down the Ctrl key on the keyboard 

while dragging a box around the hood of the car with the left mouse button. 

c) Select the three faces on the top of the hood as shown in Figure 5-9. 

d) Retain the Merge Edges option to facilitate geometry cleanup during merging. 

e) Click Apply to accept the selected faces and merge them into one face, as shown in 

Figure 5-10. 
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Figure 5-9: Three faces on hood of sedan 

 

Figure 5-10: Three faces merged on hood of sedan 
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2. Merge four faces on the trunk of the car (see Figure 5-11) using the method described 

above. The merged faces are shown in Figure 5-12. 

 

Figure 5-11: Four faces on trunk of sedan 

 

Figure 5-12: Four faces merged on trunk of sedan 
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3. Merge three faces near the rear end of the trunk of the car (see Figure 5-13) using the 

method described above. The merged faces are shown in Figure 5-14. 

 

Figure 5-13: Three faces near rear end of trunk 

 

Figure 5-14: Three faces merged near rear end of trunk 
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4. Click the FIT TO WINDOW command button  at the top left of the Global Control 

toolpad to see the full sedan in the graphics window. 

The top portion of the trunk should now consist of two large faces, as shown in 

Figure 5-15. 

 

Figure 5-15: Merged faces on sedan 
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Step 7: Mesh Faces on Car Body 

1. Create a surface mesh on the faces of the car body. 

MESH  → FACE  → MESH FACES  

 

a) Select all the faces on the car body by holding down the Shift key and using the 

left mouse button to drag a box around the whole geometry in the graphics 

window. 

! It may take a while for GAMBIT to select all the faces. GAMBIT analyzes 

each face to determine suitable meshing schemes. You should wait until all 

the edges turn red before going on to the next step. 

b) Select Tri from the Elements option button under Scheme. 

GAMBIT automatically selects the Type:Pave option. For more information 

on face meshing schemes, see the GAMBIT Modeling Guide. 

c) Enter an Interval size of 0.03 under Spacing and click the Apply button at the 

bottom of the form. 
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GAMBIT will mesh the car body surfaces. A portion of the mesh is shown in 

Figure 5-16. 

 

Figure 5-16: Surface mesh on rear of car body 

2. Remove the mesh from the display. 

! This will make it easier to see what to do in the next steps. The mesh is not 

deleted, just removed from the graphics window. 

a) Click the SPECIFY DISPLAY ATTRIBUTES command button  at the bottom of 

the Global Control toolpad. 

This action opens the Specify Display Attributes form. 
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b) Select the Off radio button to the right of Mesh near the bottom of the form. 

GAMBIT will automatically select the Mesh check box. 

c) Click Apply and close the form. 

The mesh will be removed from the graphics window. 
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Step 8: Create a Brick Around the Car Body 

1. Create a brick. 

GEOMETRY  → VOLUME  → CREATE VOLUME  

This command sequence opens the Create Real Brick form. 

 

a) Enter a value of 10 for the Width of the brick. 

b) Enter 5 for the Depth and 5 for the Height. 

c) Select Centered from the option menu to the right of Direction. 

d) Click Apply. 

2. Click the FIT TO WINDOW command button  at the top left of the Global Control 

toolpad to see the full sedan and the brick just created in the graphics window. 

3. Move the brick to the desired location relative to the sedan. 

GEOMETRY  → VOLUME  → MOVE/COPY/ALIGN VOLUMES  

This command sequence opens the Move / Copy Volumes form. 
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a) Shift-left-click the brick in the graphics window. 

b) Select Move (the default) under Volumes in the Move / Copy Volumes form. 

c) Select Translate (the default) under Operation. 

d) Enter (0, 2.5, 2.5) under Global to move the brick 2.5 units in the y direction and 

2.5 units in the z direction. 

Note that GAMBIT automatically fills in the values under Local as you enter 

values under Global. 

e) Click Apply. 
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4. Click the FIT TO WINDOW command button  at the top left of the Global Control 

toolpad to see the full sedan and the brick in the graphics window. 

The brick and sedan are shown in Figure 5-17. 

 

Figure 5-17: Brick and sedan 
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Step 9: Remove Unwanted Geometry 

You cannot simply subtract the car from the brick to produce the flow domain around 

the car, because you used “virtual geometry” to clean up the car body and GAMBIT 

cannot perform Boolean operations on virtual geometry. Instead, you must “stitch 

together” a virtual volume from the virtual faces of the car and the real faces of the 

brick. To do this you will delete the volume of the brick, leaving the lower geometry 

(the faces) behind. In the next steps, you will create virtual edges and faces.  

1. Delete the volume of the brick, leaving the faces behind. 

GEOMETRY  → VOLUME  → DELETE VOLUMES  

This command sequence opens the Delete Volumes form. 

 

a) Shift-left-click the brick in the graphics window. 

b) Unselect the Lower Geometry option and click Apply. 

The brick volume will be deleted, but all its components (faces, edges, and 

vertices) will remain in the geometry, because you deselected the Lower 

Geometry option. 
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Step 10: Create Straight Edges on the Symmetry Plane 

In this step, you will create two straight edges that will be used in the next step to 

create faces on the symmetry plane. 

1. Split the bottom edge of the symmetry plane into three sections. 

GEOMETRY  → EDGE  → SPLIT/MERGE EDGES  

This command sequence opens the Split Edge form. 

 

a) Retain the Type:Real connected option. 

b) Select Split With Point (the default). 

You will split the edge by creating a point on the edge and then using this 

point to split the edge. 

c) Use the Ctrl key and the left mouse button to zoom in to the sedan and the line at 

the bottom of the symmetry plane, similar to the view shown in Figure 5-18. 

d) Select the edge at the bottom of the symmetry plane in the graphics window. 

e) Enter a U Value of 0.64 in the Split Edge form and click Apply. 



SEDAN GEOMETRY—VIRTUAL CLEANUP Procedure 

© 1998–2007 Fluent, Inc. All rights reserved. 5-31 

The vertex needs to be close to the front of the sedan. A U Value of 0.64 will 

place the vertex in the correct position, but it is the position relative to the 

sedan that is important, not the exact U Value. 

The edge is split into two parts and a vertex is created near the front bumper 

of the sedan, as shown in Figure 5-18. 

f) Select the longer edge of the two edges just created in the graphics window. 

g) Enter a U Value of 0.57 in the Split Edge form and click Apply. 

Again, the position of the vertex relative to the sedan is more important than 

the exact U Value. 

The edge will be split and a second vertex created near the rear bumper of the 

sedan, as shown in Figure 5-18. 

Edges after split

 

Figure 5-18: Bottom edge of symmetry plane is split into three edges 
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2. Create straight edges between the two points just created and two points on the sedan. 

GEOMETRY  → EDGE  → CREATE EDGE  

This command sequence opens the Create Straight Edge form. 

 

a) Select the Virtual option to the right of Type. 

You must use Virtual because the vertex to be used on the car body is a virtual 

vertex. 

b) Zoom in to the front of the sedan, so that you can see the front bumper and the 

first vertex created on the edge at the bottom of the symmetry plane, as shown in 

Figure 5-19. 

c) Shift-left-click the first vertex created on the bottom edge of the symmetry plane. 

d) Shift-left-click the vertex on the sedan that is also on the symmetry plane, as 

shown in Figure 5-19. 

! Make sure that you select the vertex that is on the symmetry plane as well as 

the sedan. The vertex will be on an orange edge if it is on both the symmetry 

plane and the sedan geometry. 

e) Click Apply to accept the selected vertices and create an edge, as shown in Figure 

5-19. 
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Created edge

 

Figure 5-19: Edge from bottom of symmetry plane to front of sedan 

3. Create a straight edge from the second vertex created on the bottom edge of the sym-

metry plane to the rear bumper of the sedan, as shown in Figure 5-20. 

! Again, make sure you select the vertex that is on both the sedan geometry and the 

symmetry plane. 
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Created edge

 

Figure 5-20: Edge from bottom of symmetry plane to rear of sedan 
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Step 11: Create Faces on the Symmetry Plane 

In this step, you will create two new faces on the symmetry plane by stitching edges 

together. You will use the existing symmetry plane on the brick as a host. The two 

faces you create in this step will be used to create a volume in the next step. 

1. Create a new face on the symmetry plane by stitching edges together. 

GEOMETRY  → FACE  → FORM FACE  

This command sequence opens the Create Face From Wireframe form. 

 

a) Select the Type:Virtual option. 

You must use Virtual because the edges to be selected on the car body are 

virtual edges. 

b) Shift-left-click the four edges underneath the sedan, the two small diagonal edges 

on the symmetry plane, and the middle edge at the bottom of the symmetry plane. 

! The area under the sedan where the edges to be selected are located is shown 

in Figure 5-21, and the edges to be selected are shown in Figure 5-22. 
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Region encompassed by first face

created on symmetry plane 

 

Figure 5-21: Area under sedan where edges to be selected are located 

! You should select seven edges in total. Pay particular attention to any very 

small edges. If you select an incorrect edge, Shift-middle-click on the edge to 

deselect it and select the edge next to it. 
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Figure 5-22: Edges used to create face at bottom of sedan 

c) Select the Host check box in the Create Face From Wireframe form. 

d) Select Face from the Host option menu. 

e) Shift-left-click the back face of the brick (the symmetry plane) in the graphics 

window, as shown in Figure 5-23. 

If you select the wrong face, Shift-middle-click on the face to deselect it and 

select the face next to it. 

f) Enter 0.001 in the Tolerance text entry box. 

g) Click Apply to accept the selection and create the face. 
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Figure 5-23: Symmetry plane of the brick 

2. Create a second face on the symmetry plane. 

a) Check that the Virtual option is selected next to Type. 

b) Left-click in the Edges list box in the Create Face From Wireframe form. 

c) Select all the edges shown in Figure 5-24. 

! You should select 25 edges in total. 

d) Left-click in the list box to the right of Host in the form. 

e) Shift-left-click the back face of the brick (the symmetry plane) in the graphics 

window, as shown in Figure 5-23. 

f) Click Apply to accept the selection and create the face. 
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Figure 5-24: Edges used to create face at top of sedan 

3. Verify the creation of the faces. 

GEOMETRY  → FACE  → SUMMARIZE/QUERY FACES/TOTAL ENTITIES  

This command sequence opens the Summarize Faces form. 

 

a) Left-click the black arrow to the right of the Faces list box. 

This action opens the Face List form. There are two types of pick-list forms: 

Single and Multiple. In a Single pick-list form, only one entity can be selected 

at a time. In a Multiple pick-list form, you can select multiple entities. 
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i. Select the two faces at the bottom of the Available list in the Face List form. 

! Note that the names of entities in the Available list may be different in 

your geometry. In the form shown above, the last two faces in the Avail-

able list are v_face.153 and v_face.154, but you might see faces with differ-

ent numbers. 

ii. Click the  − −> button to pick the two faces. 

The two faces will be moved from the Available list to the Picked list, and 

they will be highlighted in the graphics window. 

iii. Check that the two faces highlighted in the graphics window are the correct 

faces that you should have created in the previous steps. 

Figure 5-22 and Figure 5-24 show the faces that you should have created. 

iv. Close the Face List form. 

b) Click Reset in the Summarize Faces form to unselect the two faces in the graphics 

window. 
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Step 12: Create a Volume 

1. Use the faces to create a volume. 

GEOMETRY  → VOLUME  → FORM VOLUME  

This command sequence opens the Stitch Faces form. 

 

a) Select the Number:Single volume option. 

b) Select the Type:Virtual option. 

c) Select the symmetry-plane face in the graphics window (as shown in Figure 5-23) 

and remember the label name (for example, face.147). 

d) Left-click the black arrow to the right of the Faces list box. 

This action opens the Face List form. 
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i. Click on the All −> button to move all the faces from the Available list to the 

Picked list. 

ii. Select the name of the symmetry-plane face in the Picked list. 

The symmetry-plane face will be highlighted in the graphics window. 

iii. Click the <−−− button to move the symmetry-plane face back into the Avail-

able list. 

iv. Close the Face List form. 

e) Click Apply in the Stitch Faces form to accept the selection of the faces and create 

the volume. 

During the volume creation operation, GAMBIT redisplays the sedan face 

meshes. It is advisable, however, to turn off the face mesh displays, so that 

they do not interfere with the visibility of the entities involved in subsequent 

steps. To do so, click the SPECIFY DISPLAY ATTRIBUTES command button 

 at the bottom of the Global Control toolpad, select the Mesh:Off option on 

the Specify Display Attributes form (see Step 7.2, above), and click Apply. 
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Step 13: Mesh the Edges 

When you created the mesh on the faces of the sedan, you used a fine mesh. For the 

volume, you will create a more coarse mesh, so you will need to instruct GAMBIT to 

gradually change the mesh density between the coarse and fine meshes. To do this, 

you will specify the distribution of nodes along some edges in the geometry. 

1. Define the grid density on three edges of the geometry underneath the sedan. 

MESH  → EDGE  → MESH EDGES  

This command sequence opens the Mesh Edges form. 

 

a) Select the edges marked A, B, and C in Figure 5-25 (the two small edges you 

created underneath the sedan and the middle section of the edge underneath the 

sedan that you split into three sections). 
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The edges will change color and an arrow and several circles will appear on 

each edge. 

A 

C 
B 

 

Figure 5-25: Edges underneath the sedan to be selected for edge meshing 

b) Check that Apply is selected to the right of Grading in the Mesh Edges form and 

that Successive Ratio is selected from the Type option menu. 

The Successive Ratio option sets the ratio of distances between consecutive 

points on the edge equal to the Ratio specified in the Mesh Edges form. 

c) Retain the default Ratio of 1. 

d) Check that Apply is selected to the right of Spacing. Select Interval size from the 

option menu under Spacing and enter a value of 0.03 in the text entry box. 

e) Click the Apply button at the bottom of the form. 

Figure 5-26 shows the mesh on two of the edges underneath the sedan. 
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Figure 5-26: Edge meshing near the front of the sedan 

2. Set the default variable that invokes flexible grading of the edges. 

a) Select Defaults from the Edit menu on the main menu bar. 

b) On the Edit Defaults form, Modify the MESH.EDGE.FLEXIBLE_GRADING default 

variable to set it to 1. 

The flexible-grading default variable controls the manner in which GAMBIT 

meshes any ungraded edges that are connected to meshed or graded edges. If 

you set the MESH.EDGE.FLEXIBLE_GRADING default variable to 1, 

GAMBIT grades the edge such that its interval lengths adjacent to the con-

necting vertex are similar to those on the already meshed or graded edge(s) to 

which it is connected. If an ungraded edge is connected to more than one 

graded or meshed edges at a single vertex, GAMBIT averages the lengths on 

the graded and/or meshed edges to determine the appropriate interval length 

on the ungraded edge. 

c) Close the Edit Defaults form. 
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Step 14: Mesh the Volume 

1. Mesh the volume with a coarser mesh than the mesh on the car faces. 

MESH  → VOLUME  → MESH VOLUMES  

This command sequence opens the Mesh Volumes form. 

 

a) Select the volume in the graphics window. 

b) Select Tet/Hybrid from the Elements option menu under Scheme in the Mesh 

Volumes form, and select TGrid from the Type option menu. 

See the GAMBIT Modeling Guide for more information on meshing schemes. 

c) Retain the default Interval size of 1 under Spacing and click the Apply button at the 

bottom of the form. 

The surface of the volume mesh is shown in Figure 5-27. 



SEDAN GEOMETRY—VIRTUAL CLEANUP Procedure 

© 1998–2007 Fluent, Inc. All rights reserved. 5-47 

 

Figure 5-27: A portion of the volume mesh 
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Step 15: Examine the Volume Mesh 

1. Select the EXAMINE MESH  command button at the bottom right of the Global 

Control toolpad.  

This action opens the Examine Mesh form. 

 

a) Click Update at the bottom of the Examine Mesh form. 
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GAMBIT does not automatically update the graphics display when you open 

the Examine Mesh form or modify its specifications, such as Display Type or 

Quality Type. To update the graphics display, you must click the Update 

pushbutton located at the bottom of the form. GAMBIT displays the Update 

pushbutton label in red lettering whenever the display needs to be updated to 

reflect the current Examine Mesh specifications. 

Some Examine Mesh operations automatically update the graphics display. 

For example, if you select the Display Type:Range option and click one of the 

histogram bars (see below), GAMBIT automatically updates the display. 

b) Select Range under Display Type at the top of the form. 

The 3D Element type selected by default at the top of the form is a brick . 

You will not see any mesh elements in the graphics window when you first 

open the Examine Mesh form, because there are no hexahedral elements in the 

mesh. 

c) Left-click on the tetrahedron icon  next to 3D Element near the top of the 

form. 

The mesh elements will now be visible in the graphics window. 

d) Select EquiSize Skew from the Quality Type option menu. 

This is the default skewness measure for tetrahedra in TGrid. 

e) Left-click the histogram bars that appear at the bottom of the Examine Mesh form 

to highlight elements in a particular quality range. 

Figure 5-28 shows the view in the graphics window if you click on the fifth bar 

from the right on the histogram (representing cells with a skewness value 

between 0.7 and 0.8). These low values for the maximum skewness indicate 

that the mesh is acceptable. 

The histogram consists of a bar chart representing the statistical distribution 

of mesh elements with respect to the specified Quality Type. Each vertical bar 

on the histogram corresponds to a unique set of upper and lower quality 

limits. 
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Figure 5-28: Elements within a specified quality range 

f) Close the Examine Mesh form by clicking the Close button at the bottom of the 

form. 
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Step 16: Set Boundary Types 

1. Remove the mesh from the display before you set the boundary types. 

This makes it easier to see the edges and faces of the geometry. The mesh is not 

deleted, just removed from the graphics window. 

a) Click the SPECIFY DISPLAY ATTRIBUTES command button  at the bottom of 

the Global Control toolpad.  

b) Select the Off radio button to the right of Mesh near the bottom of the form. 

c) Click Apply and close the form. 

2. Set boundary types for the sedan. 

ZONES  → SPECIFY BOUNDARY TYPES  

This command sequence opens the Specify Boundary Types form. 



Procedure SEDAN GEOMETRY—VIRTUAL CLEANUP 

5-52 © 1998–2007 Fluent, Inc. All rights reserved. 

 

a) Define the pressure inlet boundary. 

i. Select PRESSURE_INLET in the Type option menu. 

ii. Check that Faces is selected as the Entity. 

iii. Shift-left-click the face on the brick in front of the car in the graphics window 

(marked A in Figure 5-29) and click Apply to accept the selection. 

This face will be set as a pressure inlet. 
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GAMBIT will give the boundary a default name based on what you select 

in the Type and Entity lists (pressure_inlet.1 in this example). You can also 

specify a name for a boundary by entering a name in the Name text entry 

box. 

A 

B 

 

Figure 5-29: Pressure inlet (A) and pressure outlet (B) for the sedan geometry 

b) Define the pressure outlet boundary. 

i. Change the Type to PRESSURE_OUTLET by selecting it from the option menu 

below Type. 

ii. Select the face on the brick behind the car in the graphics window (marked B 

in Figure 5-29) and click Apply to accept the selection. 

c) Define symmetry boundary types for the two faces on the symmetry plane of the 

brick. 

i. Enter “symmetry1” in the Name text entry box. 

ii. Select SYMMETRY from the Type option menu. 

iii. Select the two faces you created on the symmetry plane of the brick (the faces 

marked C and D in Figure 5-30) and click Apply to accept the selection. 

GAMBIT will merge the two faces into a single symmetry zone. 
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C

D
 

Figure 5-30: Two faces created on the symmetry plane of the brick 

d) Define symmetry boundary types for the top face of the brick and the side face 

opposite the symmetry plane. 

i. Enter “symmetry2” in the Name text entry box. 

ii. Check that SYMMETRY is selected in the Type option menu. 

iii. Select the faces on the brick that are above and to the side of the sedan (the 

faces marked E and F in Figure 5-31) and accept the selection. 
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E

F

 

Figure 5-31: Two symmetry boundaries for the sedan geometry 

The pressure inlet, pressure outlet, and symmetry boundaries for the sedan 

geometry are shown in Figure 5-32. (NOTE: To display the boundary types in 

the graphics window, select the Show labels options on the Specify Boundary 

Types form. To display colors associated with each boundary-type assign-

ment, select the Show colors option.) 
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Figure 5-32: Boundary types for the sedan geometry 

Note that you could also specify the remaining outer edges of the sedan 

geometry as wall boundaries. This is not necessary, however, because when 

GAMBIT saves a mesh, any faces (in 3D) on which you have not specified a 

boundary type will be written out as wall boundaries by default. 

In addition, when GAMBIT writes a mesh, any volumes (in 3D) on which you 

have not specified a continuum type will be written as fluid by default. This 

means that you do not need to specify a continuum type in the Specify Contin-

uum Types form for this tutorial. 
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Step 17: Export the Mesh and Save the Session 

1. Export a mesh file for the sedan. 

File → Export → Mesh… 

This command sequence opens the Export Mesh File form. 

 

a) Enter the File Name for the file to be exported (sedan.msh). 

b) Click Accept in the Export Mesh File form. 

The file is written to your working directory. 

(NOTE: During mesh export, GAMBIT displays a warning message in the 

Transcript window indicating that at least one geometric entity in the model is 

unmeshed. The unmeshed entity is the real host symmetry-plane face (see Step 

11), which is not included as part of the flow volume (see Step 12).) 

2. Save the GAMBIT session and exit GAMBIT. 

File → Exit 

GAMBIT will ask you whether you wish to save the current session before you 

exit. 

 

a) Click Yes to save the current session and exit GAMBIT. 



Summary SEDAN GEOMETRY—VIRTUAL CLEANUP 

5-58 © 1998–2007 Fluent, Inc. All rights reserved. 

5.5 Summary 

This tutorial illustrated how to import geometry from an external CAD package as an 

IGES file, and mesh it. Several geometry “cleanup” operations were demonstrated. Addi-

tional geometry was created to construct a box around the car-body geometry, and an 

unstructured tetrahedral volume mesh was generated. 

 

 

 


